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NEW QUESTION: 1
What is the most common role that has access to almost all platform features, functions, and
data?
A. Security Admin [security_admin]
B. Sys Admin [sys_admin]
C. Admin [sn_admin]
D. System Administrator [admin]
E. Base Admin [base_admin]
Answer: C (LEAVE A REPLY)
Reference:
https://developer.servicenow.com/dev.do#!/guides/quebec/now-platform/glossary/developer-
glossary

NEW QUESTION: 2
Which of the following statements describes how data is organized in a table?
A. A column is a field in the database and a record is one user
B. A column is one field and a record is one row
C. A column is one field and a record is one column
D. A column contains data from one user and a record is one set of fields
Answer: (SHOW ANSWER)
InServiceNow (and databases in general), data is stored intables, which consist of:
Columns (Fields):Representindividual data attributes(e.g., Name, Email, Status).
Rows (Records):Representindividual entriesin the table (e.g., a specific Incident or User).
Key Concepts:Table
Columns (Fields)
Rows (Records)
Incident
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Number, Caller, Priority, Description
Each unique incident entry
User
Name, Email, Role, Department
Each individual user record
A column represents a single field (data attribute), such as "Priority" or "Short Description." A row
represents a record (entry in the table), such as an individual incident or user.
A: A column is a field in the database and a record is one user#Incorrect Records are not limited
to users; a record could be an Incident, Change, or any other entry.
C: A column is one field and a record is one column#Incorrect
Arecord is not a single column; a record consists of multiple fields (columns).
D: A column contains data from one user and a record is one set of fields#Incorrect Columns
contain data for all users/records, not just one user.
A record is one row, not just a set of fields.
Why is "B. A column is one field and a record is one row" the Correct Answer?Why the Other
Options Are Incorrect?
ServiceNow Docs: Understanding Tables and Fieldshttps://docs.servicenow.com/en-
US/bundle/utah-platform-
administration/page/administer/metadata/concept/c_TablesAndFields.html References from
Certified System Administrator (CSA) Documentation:

NEW QUESTION: 3
Which core table in the ServiceNow platform provides a series of standard fields used on each of
the tables that extend it, such as the Incident [incident] and Problem [problem] tables?
A. Assignment [assignment]
B. Service [service]
C. Task [task]
D.Workflow [workflow]
Answer: C (LEAVE A REPLY)

NEW QUESTION: 4
On a filter condition, which component is always a choice list?
A. Operator
B. Filter Criteria
C. Operation
D. Match Criteria
Answer: C (LEAVE A REPLY)
Reference:
https://docs.servicenow.com/bundle/rome-platform-user-interface/page/use/common-ui-
elements/concept/c_Con
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NEW QUESTION: 5
Which application is used to change the number format per table?
A. System Maintenance
B. Number Maintenance
C. Table Maintenance
D. Record Maintenance
Answer: B (LEAVE A REPLY)

NEW QUESTION: 6
When working on a form, what is the difference between Insert and Update operations?
A. Insert creates a new record and Update saves changes, both remain on the form
B. Insert saves changes and remains on the form, Update saves changes and exits the form
C. Insert creates a new record and Update saves changes, both exit the form
D. Insert saves changes and exits the form, Update saves changes and remains on the form
Answer: C (LEAVE A REPLY)

NEW QUESTION: 7
What is specified in an Access Control rule?
A. Table Schema, CRUD, and User Authentication
B. Object and Operation being secured; Permissions required to access the object
C. security_admin
D. Groups, Conditional Expressions and Workflows
Answer: (SHOW ANSWER)

NEW QUESTION: 8
On Access Control Definitions, what are ways you can set the permissions on a Table?
Choose 3 answers
A. Script that sets the answer variable to true or false
B. Roles
C. Groups
D. CRUD
E. Conditional Expressions
Answer: (SHOW ANSWER)

NEW QUESTION: 9
Which element is used to track items not saved with a field, in a record?
A. Sidebar
B. List Editor
C. Activity formatter
D. Dictionary
Answer: C (LEAVE A REPLY)
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TheActivity Formatterin ServiceNow is a UI element that trackschanges and updatesmade to a
record, including actionsnot saved directly within a field.
Displays atimeline of record updates, including comments, work notes, and field changes.
Capturessystem-generated events(such as status changes).
Allows users to viewhistorical activityon a record.
A: Sidebar- Thesidebarprovidesquick access to navigation menus, butdoes not track unsaved
field changes.
B: List Editor- TheList Editorallowsinline editingof records but doesnot track changes separately.
D: Dictionary- TheDictionarydefines fields and tables but doesnot track changes made to records.
ServiceNow Activity Formatter
ServiceNow CSA Training Module:"Working with Activity Streams and Record History" Key
Features of the Activity Formatter:Why Other Answers Are Incorrect:References from Certified
System Administrator (CSA) Official Documentation:

NEW QUESTION: 10
Typically, based on Best Practice, which of the following interactions is used to make fields
mandatory, read- only, and/or hidden?
A. O Client Scripts
B. O UI Policies
C. O Business Rules
D. O UI Actions
Answer: B (LEAVE A REPLY)
UI Policiesare the preferred method to dynamically control the visibility, read-only state, or
mandatory status of form fieldswithout requiring a page reload.
Best Practicesuggests usingUI Policiesover Client Scripts whenever possible because UI Policies
execute on the client side and are easier to manage.
Theydo not require scriptingin most cases and provide asimple rule-based approach.
Explanation of Incorrect Options:
Client Scripts (A)# Used for executing JavaScript logic in the browser, but making fields
mandatory or hidden should be done via UI Policies.
Business Rules (C)# Run on the server-side and do not directly affect form fields in real-time.
UI Actions (D)# Used for creating buttons, links, or context menu actions;not for modifying field
properties.
Reference:
ServiceNow Docs - UI Policies

NEW QUESTION: 11
What does ServiceNow recommend as a best practice regarding data imports?
A. Adjust your Transform maps, after the data is loaded into the target table.
B. Use extremely large Import Sets, instead of multiple large Import Sets.
C. Create a new Import set table for each new data load.
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D. Plan time before your import to remove obsolete or inaccurate data.
E. Monitor data quality and clean imported data, using the Data Scrub Workspace.
Answer: (SHOW ANSWER)
This is a best practice because it reduces the amount of data that needs to be imported,
transformed, and stored in ServiceNow, and improves the data quality and performance of the
system1.
ReferencesImport and export resources page

NEW QUESTION: 12
Which term refers to application menus and modules which you may want to access quickly and
often?
A. Breadcrumb
B. Favorite
C. Tag
D. Bookmark
Answer: (SHOW ANSWER)
In ServiceNow,Favoritesallow users to quickly accessapplication menus and modulesthat they
frequently use.
By marking an application menu or module as a favorite, it appears under theFavorites tab in the
Application Navigator, making navigation faster and more efficient.
(A) Breadcrumb - Incorrect
Breadcrumbs in ServiceNow show thenavigation pathwithin a list view or form.
They help users filter data quickly but donotstore shortcuts for quick access.
(B) Favorite - Correct
TheFavorite featurein ServiceNow allows users to save frequently used menus and modules for
quick access.
Users canadd, remove, and reorderfavorites for better personalization.
Located in theApplication Navigator, favorites appear at the top for easy access.
Favorites can include forms, records, reports, or dashboards.
(C) Tag - Incorrect
Tagsare used toorganize and categorize records(e.g., incidents, problems, change requests).
Tags help users group related records but donotcreate direct menu shortcuts.
(D) Bookmark - Incorrect
ServiceNow doesnotuse the term "Bookmark" for quick access to menus and modules.
While users can bookmark URLs in a web browser, this is different from ServiceNow's built-
inFavoritesfeature.
Explanation of Each Option:
Users cancustomize Favoritesby renaming them or selecting an icon for better visibility.
Admins canpre-configure favoritesfor users based on roles to improve productivity.
Favorites improveuser efficiencyby reducing the number of clicks needed to reach frequently
used items.
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ServiceNow Docs: Using Favorites in the Application Navigator
https://docs.servicenow.com
ServiceNow Community: Personalizing the Application Navigator with Favorites
https://community.servicenow.com
Additional Notes & Best Practices:References from Certified System Administrator (CSA)
Documentation:

NEW QUESTION: 13
On a form, which type of Geld has this icon which can be clicked, 10 S00 a preview of the
associated record?

A. Preview
B. Quickview
C. Reference:
D. Drilkdown
E. Lookup
F. Snapshot
Answer: C (LEAVE A REPLY)

NEW QUESTION: 14
How is a group defined in ServiceNow?
A. A group defines a set of users that share the same job title
B. A group is one record stored in the Group Type [sys_user_group_type] table
C. A group is one record stored in the Group [sys_user_group] table
D. A group defines a set of users that share the same location
Answer: C (LEAVE A REPLY)

NEW QUESTION: 15
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Which action can be selected to apply pre-defined or custom conditions to filter and generate
specified data in the Visualization Designer?
A. Preview
B. Try It
C. Execute
D. Run
Answer: A (LEAVE A REPLY)
InVisualization Designer, used in thePerformance Analytics and Reportingspace of ServiceNow,
the
"Preview"button is used to execute the current visualization setup and show how the filters and
conditions apply to your data. This allows the report builder to validate the design without
finalizing or publishing it.
* Try: Not an available action in Visualization Designer.
* Execute: More related to scripting or automation contexts.
* Run: Used in reports or scripts but not the specific action in Visualization Designer.
Reference:ServiceNow Docs: Visualization DesignerAvailable fromRomeand enhanced inSan
Diego and later

NEW QUESTION: 16
What access does a user need to be able to import articles to a knowledge base?
A. sn_knowledge contribute
B. sn_knowledge_import
C. Can import
D. Can contribute
Answer: D (LEAVE A REPLY)

Valid CSA Dumps shared by BraindumpsPass.com for Helping Passing CSA Exam!
BraindumpsPass.com now offer the newest CSA exam dumps, the BraindumpsPass.com
CSA exam questions have been updated and answers have been corrected get the
newest BraindumpsPass.com CSA dumps with Test Engine here:
https://www.braindumpspass.com/ServiceNow/CSA-practice-exam-dumps.html (502 Q&As

Dumps, 40%OFF Special Discount: Exam-Tests)

NEW QUESTION: 17
The baseline Service Catalog homepage contains links to which of the following components?
A. Record Producers, Order Guides, and Item Variables
B. Record Producers, Order Guides, and Catalog Items
C. Order Guides, Item Variables, and Workflows
D. Order Guides, Catalog Items, and Workflows
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Answer: (SHOW ANSWER)

NEW QUESTION: 18
What are advantages of using Flow Designer? (Choose three.)
A. Reduces technical debt
B. Supports advanced developers
C. Enables complicated scripting
D. Smooth integration with 3rd party systems
E. Less manual scripting
Answer: A,D,E (LEAVE A REPLY)

NEW QUESTION: 19
When moving a homepage or dashboard between instances, what must you remember?
A. Create a separate update set for them
B. They are automatically added to the update set
C. Manually add them to the update set
D. They cannot be moved via update set
Answer: (SHOW ANSWER)

NEW QUESTION: 20
What Service Catalog feature do you use to organize items into logical groups?
A. Sections
B. Categories
C. Variable sets
D. Catalog items
Answer: (SHOW ANSWER)

NEW QUESTION: 21
What do you click when you have made modification to your report, and your want to see the
results without saving?
A. Execute
B. Test
C. Preview
D. Try ir
E. Run
Answer: E (LEAVE A REPLY)

NEW QUESTION: 22
Knowledge Base Search results can be sorted by which of the following? (Choose three.)
A. Manager assignment
B. Relevancy
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C. Popularity
D. Number of views
E. Most recent update
Answer: B,D,E (LEAVE A REPLY)

NEW QUESTION: 23
There are _____ common types of Interfaces (Numeric Value)
6: There are six common types of interfaces
A. Timelines: Used to track tasks or projects
B. Maps: Display ServiceNow data graphically on a Google map
C. Homepage: Consists of navigational elements, functional controls, and platform information.
D. List: Display records from a data table, as well as allow you to edit the record information using
the List
Editor functionally.
E. Dashboard: Enable you to display multiple performance analytics, reporting and other widgets
on a
single screen.
F. Form: Data is entered into ServiceNow through forms
Answer: F (LEAVE A REPLY)

NEW QUESTION: 24
Which tool is used to define relationships between fields in an import set table and a target table?
A. Transform Schema
B. Schema Map
C. Dictionary Map
D. Transform Map
E. Field Transformer
F. Import Designer
Answer: D (LEAVE A REPLY)
ATransform Mapin ServiceNow is a tool used to define relationships betweenfields in an import
set tableandfields in a target table. It helps map incoming data to the appropriate fields within the
ServiceNow database when importing data from external sources.
Data is loadedinto anImport Set Table.
ATransform Mapis created to define how fields from the import set correspond to fields in the
target table.
TheTransformation Processis executed, applying the mapping rules.
The data is stored in theTarget Tablewith any specified transformations applied.
Supportsfield mapping,scripted transformations, andcoalesce fields(for avoiding duplicate
records).
Allows fordata cleansing and standardizationduring the transformation process.
Can be reused for multiple data imports.
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A: Transform Schema# No such concept exists in ServiceNow.
B: Schema Map# Provides a visual representation of table relationships but does not define field
mappings for imports.
C: Dictionary Map# Used for mapping between dictionary definitions, not for transforming import
set data.
E: Field Transformer# Not a ServiceNow tool.
F: Import Designer# No such module in ServiceNow.
Reference:ServiceNow Docs:Import Sets Key Concepts
ServiceNow Docs: Transform Maps
ServiceNow CSA Official Study Materials

NEW QUESTION: 25
When would you use the following steps?
1, Homepage Admin > Pages
2. Right click on Homepage record
3. Select Unioad Portal Page
A. To publish a Homepage to the Portal
B. To retire a Homepage
C. To delete a Homepage
D. o To add a Homepage to an update set
Answer: (SHOW ANSWER)
In ServiceNow,homepages(classic dashboards) are part of the user experience, and
administrators may need tomove them between instancesusing update sets.
Homepage Admin > Pages- This is where homepages are managed.
Right-click on a Homepage record- This brings up additional options.
Select "Unload Portal Page"- This action ensures that the homepage iscaptured in an update set,
making it available for export to another instance.
Homepagesdo not automatically get addedto an update set when modified.
The "Unload Portal Page" option forces the homepage to be included in the update set.
This is necessary when moving homepages fromdevelopment to productionenvironments.
A: To publish a Homepage to the Portal- This stepdoes not publisha homepage; it just makes it
available for update sets.
B: To retire a Homepage- Retiring a homepage involvesdisablingor removing it, not adding it to an
update set.
C: To delete a Homepage- Deleting a homepage is done via the UI but does not require these
specific steps.
ServiceNow Update Sets and Homepages
ServiceNow CSA Training Module:"Moving Configuration Changes Between Instances"
Explanation of the Given Steps:Why This Process is Used for Update Sets:Why Other Answers
Are Incorrect:
References from Certified System Administrator (CSA) Official Documentation:
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NEW QUESTION: 26
What are the 6 methods available for user authentication?
A. OAuth 2.0: The user name and password of OAuth identity provider, which has a matching
user account in the database.
B. Digest Token: An encrypted digest of the user name and password in the user record.
C. Multifactor: The user name and password in the database and passcode sent to the user's
mobile device that has Google Authenticator installed
D. Local Database: The user name and password in their user record in the instance database.
E. LDAP: The user name and password are accessed via LDAP in the corporate directory, which
has a matching user account in the database.
F. SAML 2.0: The user name and password configured in a SAML identity provider account,
which has a matching user account in the database.
Answer: (SHOW ANSWER)

NEW QUESTION: 27
What is the best practice related to using the Default Update Set for moving customizations
between instances?
A. Merge Default update sets before moving between instances
B. Submit Default update set to application repository
C. You should not use the Default Update sets for moving between instances
D. Keep Default update set to maximum of 20 records, for troubleshooting purposes
Answer: C (LEAVE A REPLY)
Reference:
https://docs.servicenow.com/bundle/rome-application-development/page/build/system-update-
sets/reference/defa

NEW QUESTION: 28
What are the three key tables in an enterprise CMDB? Choose 3 answers.
A. sn_emdb
B. sn_emdb_ci
C. Ey omdb
D. emdb_bak
E. omdb_ci
F. sn_emdb_bak
G. omadb_rel_ci
Answer: C,E,G (LEAVE A REPLY)

NEW QUESTION: 29
What section on a task record is used to see the most recent updates made to a record?
A. Audit Log

https://www.exam-tests.com/CSA-exam/ServiceNow.CSA.v2025-08-07.q124.html
https://www.exam-tests.com/CSA-exam/ServiceNow.CSA.v2025-08-07.q124.html
https://www.exam-tests.com/CSA-exam/ServiceNow.CSA.v2025-08-07.q124.html


B. Activity Stream
C. Timeline
D. Related List
Answer: B (LEAVE A REPLY)

NEW QUESTION: 30
Security rules are defined to restrict the permission of users from viewing and interacting with
data. What are these security rules called?
A. Role Assignment Rules
B. CRUD Rules
C. Scripted User Rules
D. Access Control Rules
E. User Authentication Rules
Answer: (SHOW ANSWER)
Access Control Rules (ACLs)in ServiceNow define security rules thatcontrol user
permissionsforviewing, creating, updating, and deletingrecords in the system. These rules ensure
that users can onlysee and interact with the data they are authorized to access.
D: Access Control Rules
ACLsdefine security restrictionsat thefield, table, and record level.
These rules useconditions, scripts, and role-based permissionsto enforce security.
Example: A user with theitilrole may view incidents, but only users with theadminrole can delete
them.
A: Role Assignment Rules
ServiceNowassigns roles to users, butroles alone do not define security rules.
ACLs controlwhat users can do, whilerolesonly grant potential access.
B: CRUD Rules
CRUD (Create, Read, Update, Delete)definespermission types, butnot security rules.
ACLs enforce CRUD operations based on roles and conditions.
C: Scripted User Rules
No such term as"Scripted User Rules"in ServiceNow security.
Possibly confused withScripted ACLs, which are part of Access Control Rules.
E: User Authentication Rules
Authentication rules controluser login mechanisms(LDAP, SSO, OAuth) but donot define access
to data.
ACLs managedata security, while authentication ensuresusers are who they claim to be.
References:ServiceNow Documentation:Access Control Rules Overview
ServiceNow Developer Guide:Creating and Managing ACLs

NEW QUESTION: 31
What types of entities can receive task assignments, in ServiceNow?
Choose 2 answers
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A. Groups
B. Users
C. Departments
D. Teams.
Answer: A,B (LEAVE A REPLY)
In ServiceNow, tasks (such as Incidents, Change Requests, and Service Requests) can be
assigned toindividual usersorgroupsto manage workload distribution efficiently.
A: Groups
Groups in ServiceNow represent a collection of users with common roles or responsibilities.
Tasks are often assigned to groups first, allowing any member to take ownership.
Example:
IT Support Groupfor handling incident tickets.
Change Advisory Board (CAB)for approving changes.
B: Users
Individual users can receive task assignments directly.
Assigned users are responsible for completing or updating the task.
Example:
A specificService Desk Agentassigned to resolve an incident.
C: Departments
Departments in ServiceNow representorganizational divisions(e.g., HR, IT, Finance), but they
donotreceive task assignments.
Assignments are made to groups or individuals within departments, not the department itself.
D: Teams
"Teams" is not a structured entity in ServiceNow for task assignments.
While some organizations may informally refer to groups as "teams," the platform
recognizesGroupsandUsersas valid task recipients.
References:Official ServiceNow Documentation:Assigning Tasks
ServiceNow Administration Guide:Users and Groups

Valid CSA Dumps shared by BraindumpsPass.com for Helping Passing CSA Exam!
BraindumpsPass.com now offer the newest CSA exam dumps, the BraindumpsPass.com
CSA exam questions have been updated and answers have been corrected get the
newest BraindumpsPass.com CSA dumps with Test Engine here:
https://www.braindumpspass.com/ServiceNow/CSA-practice-exam-dumps.html (502 Q&As

Dumps, 40%OFF Special Discount: Exam-Tests)

NEW QUESTION: 32
The ServiceNow Virtual Agent provides assistance within a messaging interface. Which capability
allows end users to configure virtual Agent to intercept and help resolve submitted incidents?

https://www.exam-tests.com/CSA-exam/ServiceNow.CSA.v2025-08-07.q124.html
https://www.braindumpspass.com/ServiceNow/CSA-practice-exam-dumps.html


A. Incident Auto-Resolution
B. Ticket Resolver
C. Virtual Agent Helper
D.Web Intelligence
Answer: A (LEAVE A REPLY)
TheServiceNow Virtual Agentis an AI-powered chatbot that assists userswithin a messaging
interface(such as Microsoft Teams, Slack, or Service Portal). It helpsautomate resolutions and
guide usersthrough common IT and HR issues.
Incident Auto-ResolutionallowsVirtual Agenttoautomatically detect, intercept, and resolve
incidentsbefore they reach a human agent.
It appliesmachine learning (ML) and predefined rulesto determine whether a ticketcan be resolved
through automation.
If an issuematches a known solution, the Virtual Agentprovides the resolution stepsto the user.
If self-resolution fails, the ticket isescalated to an agent.
It is anofficial feature in ServiceNow Virtual Agent.
It allows the chatbot tointercept incidentsand attempt resolution before escalation.
B: Ticket Resolver#Incorrect
"Ticket Resolver" isnot an official ServiceNow feature.
C: Virtual Agent Helper#Incorrect
No feature called "Virtual Agent Helper" exists in ServiceNow.
D: Web Intelligence#Incorrect
Web Intelligenceisnot related to ServiceNow Virtual Agent.
What is Incident Auto-Resolution?Why is "A. Incident Auto-Resolution" the Correct Answer?Why
the Other Options Are Incorrect?
ServiceNow Docs: Virtual Agent & Incident Auto-Resolutionhttps://docs.servicenow.com/en-
US/bundle/utah- virtual-agent/page/administer/virtual-agent/concept/incident-auto-resolution.html
References from Certified System Administrator (CSA) Documentation:This confirms that"Incident
Auto- Resolution" is the correct answer, as it allowsVirtual Agent to intercept and resolve
submitted incidents automatically.

NEW QUESTION: 33
An IT manager is responsible for the Network and Hardware assignment groups, each group
contains 5 team members. These team members are working on many tasks, but the manager
cannot see any tasks on the Service Desk > My Groups Work list. What could explain this?

A. The Service Desk > My Groups Work list shows active work tasks that are not yet assigned.
B. The manager does not have the itil role.
C. The manager is not a member of the Service Desk group.
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D. The manager is not a member of the Network and Hardware groups.
E. The Assignment Group manager field is empty.
Answer: A (LEAVE A REPLY)
In ServiceNow, the"Service Desk > My Groups Work"module is designed to display tasks
assigned to a groupbut not yet assigned to an individual user.This means that even if an IT
manager oversees theNetworkandHardwareassignment groups, they will not see any tasks in this
listif all tasks have already been assigned to specific individualswithin the group.
Let's break down whyoption Ais the correct answer and why the other options are incorrect:
The"My Groups Work"list only shows tasks that are assigned to thegroupbut have not been
assigned to a specificindividualwithin the group.
If all tasks are assigned to specificteam members, then the manager will not see any tasks in this
list.
The IT manager can verify this by navigating to theTask List(e.g., Incidents, Changes, or
Requests) and filtering by theNetworkandHardwareassignment groups.
Explanation for Correct Answer (A):
Theitil roleallows users toview, create, update, and resolve incidents, changes, problems, and
other ITSM tasks.
However, not having this role wouldrestrict accessto various ITSM functionalities, but itdoes
notimpact whether tasks appear inMy Groups Work.
If the manager lacks theitilrole, they might have trouble accessing or modifying tasks, but this
wouldn't explain why they don't see anything in the list.
TheService Desk groupis a separate entity in ServiceNow, typically associated with incident
handling and user support.
TheMy Groups Workmodule isnot restricted to the Service Desk group-it displays work assigned
toany groupthe user belongs to.
Since the manager is responsible for theNetwork and Hardwaregroups, being part of theService
Deskgroup is irrelevant.
If the manager wasnot a memberof these groups, they wouldn't seeany group-related tasksat all.
However, the question states that the manager isresponsible for these groups, so it's reasonable
to assume they are either a member or at least agroup managerwith visibility.
Even if they were just a manager and not an officialgroup member, they would still be able to see
the tasks assigned to the groups.
TheAssignment Group managerfield is an informational field that indicates who manages a group.
This fielddoes not controlwhat is displayed in theMy Groups Workmodule.
Even if this field were empty, it wouldn't prevent a manager (who is a group member) from seeing
unassigned tasks.
Explanation for Incorrect Answers:(B) The manager does not have the itil role.(C) The manager is
not a member of the Service Desk group.(D) The manager is not a member of the Network and
Hardware groups.
(E) The Assignment Group manager field is empty.
ServiceNow CSA Guide - User Interface and Navigation
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ServiceNow ITSM Fundamentals - Incident and Task Management
ServiceNow Role-Based Access Controls and Group Management
ServiceNow KB Articles - My Groups Work Module
References to Official Certified System Administrator (CSA) Documentation:

NEW QUESTION: 34
Which allows the creation of a task-based record from Service Catalog?
A. UI Builder
B. Flow Designer
C. Assignment Rule
D. Record Producers
E. UI Actions=
Answer: D (LEAVE A REPLY)

NEW QUESTION: 35
On what part of the ServiceNow instance, would you find the option to Impersonate User?
A. Module
B. Content Frame
C. Application Navigator
D. User Menu
Answer: D (LEAVE A REPLY)
Reference:
https://docs.servicenow.com/bundle/rome-platform-administration/page/administer/users-and-
groups/concept/c_

NEW QUESTION: 36
What is the name of the table relationship, where two or more tables are related in a bi-directional
relationship, so that the related records are visible from both tables in a related list?
A. One to Many
B. Extended
C. Database View
D. Many to Many
Answer: D (LEAVE A REPLY)

NEW QUESTION: 37
On a form, which type of Geld has this icon which can be clicked, 10 S00 a preview of the
associated record?

https://www.exam-tests.com/CSA-exam/ServiceNow.CSA.v2025-08-07.q124.html
https://www.exam-tests.com/CSA-exam/ServiceNow.CSA.v2025-08-07.q124.html
https://www.exam-tests.com/CSA-exam/ServiceNow.CSA.v2025-08-07.q124.html


A. Quickview
B. Lookup
C. Drilkdown
D. Reference:
E. Snapshot
F. Preview
Answer: D (LEAVE A REPLY)

NEW QUESTION: 38
What action will allow you to personalize layouts of columns in a list?
A. ClickGear icon > Personalize window options > Select the appropriate columns
B. Select the column to be personalized >ClickEdit icon (Penal) > Choose me options to
personage
C. Context Menu> View > Personalize
D. Select the column to be personalized and right at the header > Choose the options to
personalize
Answer: A (LEAVE A REPLY)
InServiceNow List Views, users cancustomize and personalizethe displayed columns to fit their
needs.
Open anylist view(e.g., Incidents, Requests).
Click theGear icon (#)in the top-right corner of the list.
ThePersonalize List Columnswindow appears.
Select or remove columns as needed.
ClickSaveto apply changes.
Steps to Personalize List Layout (Columns):This customization isuser-specific, meaning it only
affects the logged-in user's view.
B: Select the column to be personalized > Click Edit icon (Penal) > Choose options to personalize
NoEdit icon (Pencil) for column customizationexists in List Views.
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C: Context Menu > View > Personalize
TheContext Menu (right-click menu)allows you to filter or sort data but doesnot customize
columns.
D: Select the column to be personalized and right-click the header > Choose options to
personalize Right-clicking the column header providessorting and grouping options, not full
column customization.
Reference:ServiceNow CSA Documentation - Customizing List Views
ServiceNow Product Documentation - Personalizing List Layouts(https://docs.servicenow.com)
Final answer: A. Click Gear icon > Personalize window options > Select the appropriate columns

NEW QUESTION: 39
What resource can you use to view details of the tables and configuration items (CIs) associated
with a particular use case?
A. Scenario Dashboard
B. CMDB Use Case Modeler
C. CI Use Case Modeler
D. Common Service Data Model (CSDM) product view
Answer: D (LEAVE A REPLY)

NEW QUESTION: 40
When creating a new notification, what must you define?
Choose 3 answers
A. Linder what conditions is the notification sent
B. Settings for handling inactive user accounts
C.What is the content of the notification
D.Who receives the notification
E. The associated knowledge base
Answer: A,C,D (LEAVE A REPLY)

NEW QUESTION: 41
Which fields can be configured in reporting to perform arithmetic, coalesce, concatenation, and
length?
A. Sourcing fields
B. Computational fields
C. Function fields
D. Calculation fields
Answer: C (LEAVE A REPLY)

NEW QUESTION: 42
When importing data from a spreadsheet, which step defines where the incoming data columns
will be written in the receiving table?
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A. Field Matching
B. Load Data
C. Select Data Source
D. Schedule Transform
E. Create Transform Map
Answer: (SHOW ANSWER)
Whenimporting data from a spreadsheetinto ServiceNow, the step thatdefines where incoming
data columns will be written in the receiving tableisField Matching.
Select Data Source- Choose the spreadsheet (CSV, Excel, etc.) that contains the data.
Load Data- Uploads the data into a temporary staging table.
Create Transform Map- Defines the mapping between the source data and the target table.
Field Matching-This stepmatches the columns from the source data to the fields in the receiving
table.
Schedule Transform (if needed)- Optionally schedule automatic data transformation.
B: Load Data
This steponly loads data into a temporary tableand does not define field mapping.
C: Select Data Source
This step isonly about choosing the input file, not about mapping fields.
D: Schedule Transform
Scheduling only determineswhena transformation runs but does not define field mappings.
E: Create Transform Map
While transform maps define relationships between source and target tables,Field Matchingis the
step that actually aligns specific fields.
Reference:ServiceNow CSA Documentation - Data Import Process & Field Mapping ServiceNow
Product Documentation - Transform Maps & Field Matching(https://docs.servicenow.com)

NEW QUESTION: 43
The baseline Service Catalog homepage contains links to which of the following components?
A. Record Producers, Order Guides, and Catalog Items
B. Order Guides, Item Variables, and Workflows
C. Order Guides, Catalog Items, and Workflows
D. Record Producers, Order Guides, and Item Variables
Answer: A (LEAVE A REPLY)
TheService Catalogis a core feature in ServiceNow that provides users with a structured interface
to request services and products. Thebaseline Service Catalog homepageincludes links to key
components that help users navigate and submit requests efficiently. These components are:
Record Producers- These are forms that allow users to create records in tables other than the
Request table (e.
g., submitting an incident or a change request).
Order Guides- These help users request multiple related items in a single submission,
streamlining complex orders.
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Catalog Items- These are the individual products or services users can request, such as software
installations, hardware requests, or access requests.
Option B: "Order Guides, Item Variables, and Workflows"- Incorrect, becauseItem
VariablesandWorkflowsare not direct links on the Service Catalog homepage. Item Variables are
attributes of Catalog Items, and Workflows handle backend processing but are not listed as a
navigational component.
Option C: "Order Guides, Catalog Items, and Workflows"- Incorrect, because Workflows are not
directly linked from the homepage.
Option D: "Record Producers, Order Guides, and Item Variables"- Incorrect, because Item
Variables are part of Catalog Items but not a distinct link on the homepage.
ServiceNow Product Documentation - Service Catalog Overview
ServiceNow CSA Study Guide - Service Catalog Fundamentals
ServiceNow Docs: Service Catalog Components
Explanation of Incorrect Options:References from Certified System Administrator (CSA)
Documentation:

NEW QUESTION: 44
A subject matter expert routinely receives tasks which have been worked by first level support,
before receiving the assignment What could you suggest. to make it easier for the expert to read
only the work notes in the Activity log?
A. Click Funnel icon and select only work notes
B. Click Personalize icon and select Activity Stream
C. Right click form header > Form Layout > Add Work Notes Section
D. Click Context menu > History
E. Click Context menu > Work Notes View
Answer: A (LEAVE A REPLY)

NEW QUESTION: 45
What is the function of user impersonation?
A. Unlock Application master list
B. View custom perspectives
C. Activate verbose logging
D. Testing and visibility
Answer: D (LEAVE A REPLY)

NEW QUESTION: 46
Which would NOT appear in the History section of the Application Navigator?
A. Records
B. UI Pages
C. Lists
D. Forms
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Answer: B (LEAVE A REPLY)
TheHistory sectionin theApplication Navigatortracks recently visited records, lists, and forms
within ServiceNow. This feature allows users to quickly navigate back to previously accessed
content without searching manually.
What Appears in the History Section?The History sectionlogs user activityrelated to:
Records (Option A)- Recently viewed records from any table, such as incidents, requests, or
tasks.
Lists (Option C)- Any list views a user has accessed, such asIncident ListorChange Request List.
Forms (Option D)- Any individual record viewed in form view, such as anincident formoruser form.
Why is Option B (UI Pages) Correct?UI Pages do NOT appear in the History section.
UI Pagesare special custom pages built with Jelly scripting and used forcustom interfaces,
portals, and dashboards(e.g., Service Portal pages).
Since they do not represent individual records, lists, or forms,they are not included in the user's
History tracking.
Why Are the Other Options Incorrect?A. Records
Recordsare individual database entries (e.g., specific incidents, change requests, or users).
Since records are frequently accessed, theyare logged in History.
C: Lists
Listsdisplay multiple records from a table (e.g., all open incidents).
Since users navigate through lists frequently, theyare logged in History.
D: Forms
Formsare used to view or edit individual records (e.g., an incident form).
Since forms are commonly accessed, theyare logged in History.
Reference from Certified System Administrator (CSA) Documentation:#ServiceNow Docs -
Application Navigator & History
#ServiceNow Application Navigator Documentation
"The History section of the Application Navigator displays a list of the records, lists, and forms
that you have recently accessed."
"Custom UI Pages are not included in History tracking."

Valid CSA Dumps shared by BraindumpsPass.com for Helping Passing CSA Exam!
BraindumpsPass.com now offer the newest CSA exam dumps, the BraindumpsPass.com
CSA exam questions have been updated and answers have been corrected get the
newest BraindumpsPass.com CSA dumps with Test Engine here:
https://www.braindumpspass.com/ServiceNow/CSA-practice-exam-dumps.html (502 Q&As

Dumps, 40%OFF Special Discount: Exam-Tests)

NEW QUESTION: 47
A customer requests the following data quality measures be added:
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1. Incident numbers should be read-only on all lists and forms, for all users.
2. Short Description field should be mandatory, on all records, across all applications, on insert.
Which type of policy would you use to meet this requirement?
A. Data policy
B. Data Quality Policy
C. Dictionary Design Policy
D. Field Criteria Policy
Answer: A (LEAVE A REPLY)

NEW QUESTION: 48
An order for new officeequipmenthas Men placed through the Service Catalog. How would you
view the lists of requests after the orders have Menplaced?
A. All > Service Catalog > Open Records > Items
B. In the Navigation Filter, type 'requests. Let' and press the Enter key.
C. All > Tables and Columns > Taste
D. All > Service Catalog > Requests
Answer: D (LEAVE A REPLY)
When a user places an order through theService Catalog, it generates aRequest
[sc_request]record in ServiceNow.
How to View Service Catalog Requests:#Navigation Path:
All > Service Catalog > Requests
This module displays:
All submitted service catalog requests
Theircurrent status(e.g., Pending Approval, Fulfilled)
AssociatedRequested Items (RITM) and Tasks (SCTASK)
A: All > Service Catalog > Open Records > Items #Incorrect
The"Items"module does not show submitted requests; it listsavailable catalog items.
B: In the Navigation Filter, type 'requests' and press Enter #Incorrect Typing"requests"might bring
up multiple unrelated records, making it inefficient.
The correct approach is to navigate toService Catalog > Requests.
C: All > Tables and Columns > Taste #Incorrect
"Tables and Columns" is used fortable managementand is not related to service catalog requests.
Also, "Taste" is atypo(likely meant to be "Tasks").
Why Other Options Are Incorrect?
Service Catalog Requests Overview
Official ServiceNow Documentation Reference:

NEW QUESTION: 49
Create Incident, Password Reset, and Report outage: what do these services in the Service
Catalog have in
common?
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A. They direct the user to a catalog UI policy
B. They direct the user to a catalog client script
C. They direct the user to a record producer
D. They direct the user to a catalog property
Answer: C (LEAVE A REPLY)

NEW QUESTION: 50
When impersonating a user for testing purposes, what is the best way to return the instance,
logged in with your user account?
A. Turn your computer off and on again
B. Clear browser cache
C. End Impersonation
D. Log out and back in
Answer: D (LEAVE A REPLY)
Reference: https://docs.servicenow.com/bundle/rome-platform-
administration/page/administer/users-and- groups/concept/c_ImpersonateAUser.html

NEW QUESTION: 51
What is the name of the string that display filter criteria?
A. Breadcrump
B. Topic
C. Choice
D. Menu
Answer: A (LEAVE A REPLY)

NEW QUESTION: 52
What actions are taken to filter a long list of records to show only those with the Category of
Hardware?
A. On Breadcrumb, click the > icon, type Hardware and click enter
B. On the Category column header, right-click and select Show > Hardware
C. On the list, locate and right-click on the value Hardware, select Show Matching
D. Right-click on magnifier type Hardware and click enter
E. Click Funnel icon, type Hardware and click enter
Answer: C (LEAVE A REPLY)
When working with along list of records, users canfilter dataquickly using theShow
Matchingfeature.
C: On the list, locate and right-click on the value Hardware, select Show Matching Right-
clickingon the"Hardware"value and selecting"Show Matching"filters the list toonly show records
where the Category is Hardware.
This is thefastestway to apply aquick filter.
A: On Breadcrumb, click the > icon, type Hardware and click enter

https://www.exam-tests.com/CSA-exam/ServiceNow.CSA.v2025-08-07.q124.html
https://www.exam-tests.com/CSA-exam/ServiceNow.CSA.v2025-08-07.q124.html
https://www.exam-tests.com/CSA-exam/ServiceNow.CSA.v2025-08-07.q124.html
https://www.exam-tests.com/CSA-exam/ServiceNow.CSA.v2025-08-07.q124.html


Breadcrumbsdo not support direct text inputfor filtering.
Breadcrumbs showexisting filtersbut are not used to type new values.
B: On the Category column header, right-click and select Show > Hardware Incorrect menu
option-There is no "Show > Hardware" selection.
Instead, users would need to use"Show Matching"(Correct Answer C).
D: Right-click on magnifier, type Hardware, and click enter
There isno "magnifier" optionfor filtering in list view.
E: Click Funnel icon, type Hardware and click enter
TheFunnel (Filter) iconis used to createadvanced filters, but it doesnotsupport direct text input like
this.
The correct way to use theFilterwould be:
Click theFunnel icon
SetCategory = Hardware
ClickRun
References:ServiceNow Documentation:Filtering Data in a List
ServiceNow UI Guide:Using the Show Matching Feature

NEW QUESTION: 53
Each knowledge bases can have unique lifecycle workflows, user criteria, category structures,
and management assignments.
A. False
B. True
Answer: B (LEAVE A REPLY)

NEW QUESTION: 54
After finishing your work on High Security Settings, what is a possible way to return to normal
admin security levels?
A. Use System Administration > Normal Security module
B. Select Normal role
C. Log out and back in
D. Select Global Update Set
E. End impersonation
Answer: (SHOW ANSWER)
When working withHigh Security Settingsin ServiceNow (such assecurity_admin role), the
systemtemporarily elevates your security privileges. To return tonormal admin security levels, the
most effective way is tolog out and log back in.
Resets Elevated Security Permissions
Thesecurity_adminrole istemporarily assignedand will beremoved upon logout.
Logging out ensures that you return todefault admin security levels.
Prevents Unintended Access
If you remain inHigh Security Mode, you might makeunauthorized changes.
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Logging outensures security compliance.
Best Practice in ServiceNow Security Administration
ServiceNow recommendslogging out after making security changestoavoid accidentally altering
critical configurations.
Why Logging Out and Back In is the Correct Answer?
A: Use System Administration > Normal Security moduleIncorrect- No such module exists in
ServiceNow.
B: Select Normal roleIncorrect- Youcannot manually remove thesecurity_adminrole. It expires
uponsession logout.
D: Select Global Update SetIncorrect- TheUpdate Set selection does not affect security roles.
E: End impersonationIncorrect-Ending impersonation only applies when using the "Impersonate
User" feature. It doesnot affect elevated security roles.
Incorrect Answer Choices Analysis:
ServiceNow Docs - Managing High Security Settings#Elevating Security Roles in ServiceNow
ServiceNow Docs - Logging Out to Reset Security Roles#Best Practices for Security Admin Role
Official ServiceNow Documentation References:
Conclusion:The correct answer is:
C: Log out and back in
Logging outremoves elevated security roles, restoringnormal admin security levels.

NEW QUESTION: 55
Groups are stored in what table?
A. User Groups [sn_user_groups]
B. Groups [sys_user_groups]
C. Group [sn_sys_user_group]}
D. Group [sys_user_group]
E. User Group [user_groups]
Answer: D (LEAVE A REPLY)

NEW QUESTION: 56
Which type of scripts run in the browser?
A. Business Rule Scripts
B. script Include Scripts
C. Policies and Client Scripts
D. Access Contral Scripts
Answer: (SHOW ANSWER)

NEW QUESTION: 57
In what order are Access Controls evaluated?
A. Field-level - mast general to most specific: then Row-level - most specific to most general
B. Table-level - most specific to most general; then Row-level - most specific to most general
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C. Table-level - most specific to most general; then Field-level - most specific to mast general
D. Field-level - most specific to most general: then Table-level - most specific to most general
Answer: C (LEAVE A REPLY)
Access Control Rules (ACLs)inServiceNowdeterminewho can access a record, table, or field.
They are evaluated in aspecific orderto ensure security.
Table-Level ACLs are evaluated first
ServiceNowfirst checks if the user has permission to access the table itself.
If the user doesnothave access at thetable level, no further checks are performed.
Field-Level ACLs are evaluated next
Once table access is granted, ServiceNow checksif the user has permission to access individual
fields.
More specific ACLs override broader ones(e.g.,incident.short_descriptiontakes priority
overincident.*).
Order of Specificity (Most Specific to Least Specific)
Field-Specific ACL(incident.short_description.read)
Wildcard Field ACL(incident.*.read)
Table-Level ACL(incident.read)
Wildcard Table ACL(*.read)
ACL Evaluation Order in ServiceNow:This ensures thatspecific rules take precedence over
general rulesfor enhanced security.
Example of ACL Evaluation in Incident Table:ACL Rule Type
Example ACL
Evaluation Order
Field-Specific
incident.short_description.read
First (Most Specific)
Wildcard Field
incident.*.read
Second
Table-Level
incident.read
Third
Wildcard Table
*.read
Last (Most General)
A: Field-level - most general to most specific; then Row-level - most specific to most
generalIncorrect- Field- level ACLs arenot evaluated first; table-level ACLs are checked before
field-level.
B: Table-level - most specific to most general; then Row-level - most specific to most
generalIncorrect-"Row- level" is not a correct termin ServiceNow ACL processing.
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D: Field-level - most specific to most general; then Table-level - most specific to most
generalIncorrect-Table- level ACLs are always evaluated before field-level ACLs.
Incorrect Answer Choices Analysis:
ServiceNow Docs - Access Control Evaluation Order#How ACLs Are Processed ServiceNow
Docs - Managing ACLs in ServiceNow#Best Practices for ACLs Official ServiceNow
Documentation References:
Conclusion:The correct answer is:
C: Table-level - most specific to most general; then Field-level - most specific to most general
Thisensures that general table permissions are granted before checking field-level
access,following a structured and secure approachto access control in ServiceNow.

NEW QUESTION: 58
On a form, which type of Geld has this icon which can be clicked, 10 S00 a preview of the
associated record?

A. Reference:
B. Lookup
C. Quickview
D. Preview
E. Snapshot
F. Drilkdown
Answer: A (LEAVE A REPLY)

NEW QUESTION: 59
Which set of steps is used to import spreadsheet data into a ServiceNow table?
A. Load Data, Create Transform Map, Run Transform
B. Select Import Set, Select Transform Map, Run Transform
C. Select Data Source, Schedule Transform
D. Define Data Source, Select Transform Map, Run Transform
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Answer: A (LEAVE A REPLY)
These are the steps to import spreadsheet data into a ServiceNow table, as explained in the
official documentation1 and the video tutorial2. The other options are either incomplete or
incorrect.
References1: Import a spreadsheet - Product Documentation: Utah - Now Support Portal2: How
To Import Data Into ServiceNow - YouTube

NEW QUESTION: 60
In addition to the admin role, which one of the following roles allows a user to add or remove
fields from a list?
A. ul_page_admin
B. personal_list
C. personal ize.control
D. ui_action_admin
Answer: (SHOW ANSWER)

NEW QUESTION: 61
Your customer wants to update a notification so it is sent to the Caller's Manager. Which action
supports this requirement?
A. On the 'Who will receive' tab on the Notification record, add the Caller field, then dot walk to
the Caller's Manager field to add it.
B. On the Notification record, create a flow and include a notification in the flow for "All receivers".
C. On the 'Send to' tab on the Notification record, set "Who will receive" to Subscribable.
D. On the 'Send to' tab on the Notification record, add the Caller field, then dot walk to the Caller's
Manager field to add it.
Answer: (SHOW ANSWER)
In ServiceNow Notification Configuration, dot-walking allows administrators to reference related
records dynamically.
# To send a notification to the Caller's Manager, you need to:
* Open the Notification record.
* Navigate to the 'Send to' tab.
* Add the Caller field.
* Use dot-walking to select the Caller's Manager field (e.g., caller_id.manager).
* Option A is incorrect because dot-walking is configured under the 'Send to' tab, not the 'Who will
receive' tab.
* Option B is incorrect because while Flow Designer can trigger notifications, it does not
specifically configure recipients based on dot-walking.
* Option C is incorrect because setting "Who will receive" to Subscribable is used for opt-in
notifications, not direct notifications to the Caller's Manager.
# Reference: ServiceNow Administration - Notification Configuration & Dot-Walking
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NEW QUESTION: 62
Which role(s) are required to impersonate a user?
Choose 2 answers
A. admin
B. sys_admin
C. security_admin
D. sys_user
E. impersonator
Answer: A,E (LEAVE A REPLY)
In ServiceNow,impersonating a userallows administrators or authorized users to temporarily
assume another user's identity. This is useful fortroubleshooting, testing permissions, and
verifying user experiences.
admin (A)
Users with theadminroleautomaticallyhave impersonation privileges.
Admin userscan impersonate any user in the system.
Example: A system admin impersonates aService Desk Agentto test access restrictions.
impersonator (E)
Theimpersonatorrole allows a user to impersonate otherswithout full admin privileges.
This role is useful forsupport teams or testerswho need to verify user permissions.
Example: A QA tester is given theimpersonatorrole to test different roles in the system.
B: sys_admin
No such role assys_adminin ServiceNow-this is likely amistyped version of "admin".
C: security_admin
security_adminis used forelevating privilegesto modify high-security settings, not for
impersonation.
D: sys_user
Thesys_usertablestores user recordsbut isnot a role.
Regular userscannotimpersonate others unless they have theimpersonatororadminrole.
References:ServiceNow Documentation:Impersonating Users
ServiceNow Security Best Practices:Understanding User Roles

NEW QUESTION: 63
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One related list, which buttons are commonly used for managing the records on the list?
Choose 3 answers
A. Publish
B. Manage
C. Edit
D. New
E. Ada
Answer: C,D,E (LEAVE A REPLY)

NEW QUESTION: 64
Tables may have a One to Many relationships. From the Service Catalog, what are examples of
tables having a one to many relationships? (Choose three.)
A. One Request can have many Requested Items
B. One Requested Item can have many Approvals
C. One Approval can have many Requests
D. One Cart can have many Requests
E. One Requested Item can have many Catalog Tasks
Answer: A,D,E (LEAVE A REPLY)

NEW QUESTION: 65
Which ServiceNow capability allows you to provide knowledge articles, via a conversational
messaging interface?
A. Now Messenger
B. Connect Agent
C. Virtual Agent
D. Agent Assist
Answer: C (LEAVE A REPLY)

NEW QUESTION: 66
A user is complaining that they are seeing a blank page, when they click Create New, from your
custom Inventory application. You have confirmed that they can see the Inventory application,
and the Create New module on the application navigator. What could be the cause of this issue?
A. Known intermittent issue with U115
B. User session has timed out
C. Create New module has a broken link
D. User has read role, but not the write role on the Inventory table
E. User should be using Chrome instead of Explorer for their browser
Answer: (SHOW ANSWER)

NEW QUESTION: 67
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What ServiceNow feature can be triggered by events, and is used to inform users about activities
or updates in ServiceNow?
A. Notifications
B. Alerts
C. Texts
D. Events
E. Emails
Answer: D (LEAVE A REPLY)
Reference:
https://docs.servicenow.com/bundle/rome-platform-administration/page/administer/platform-
events/concept/even

NEW QUESTION: 68
Which modules can you use to create a new table?
Choose 2 answers
A. Tables & Columns
B. Schema Map
C. Dictionary
D. Tables
Answer: A,D (LEAVE A REPLY)
In ServiceNow, new tables can be created using theTables & Columnsmodule or
theTablesmodule.
Navigation:System Definition > Tables & Columns
Allows admins tocreate and modify tables, including:
Adding columns (fields)
Setting relationships
Defining attributes
Navigation:System Definition > Tables
A simpler interface for creating tableswithout managing columns immediately.
B: Schema Map #Incorrect
Schema Mapvisualizestable relationships but does not allow table creation.
C: Dictionary #Incorrect
TheSystem Dictionary (sys_dictionary)is used tomanage fields and attributes, not create tables.
Creating Tables in ServiceNow
Understanding Tables & Columns
1. Tables & Columns Module(Correct Answer)2. Tables Module(Correct Answer)Why Other
Options Are Incorrect?Official ServiceNow Documentation Reference:

NEW QUESTION: 69
What is used to determine user access to knowledge bases or a knowledge article?
A. sn_kb_read, sn_article_read
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B. Privacy Settings
C. Read Access Flag
D. User Criteria
Answer: (SHOW ANSWER)
Reference: https://docs.servicenow.com/bundle/rome-servicenow-
platform/page/product/knowledge- management/concept/user-access-knowledge.html

NEW QUESTION: 70
Configuration will not affect what others see on their forms.
A. False
B. True
Answer: A (LEAVE A REPLY)

NEW QUESTION: 71
Which component of a table contains a piece of data for one record?
A. Factor
B. Field
C. Datapoint
D. Element
E. Item
Answer: (SHOW ANSWER)
Reference:
https://docs.servicenow.com/bundle/rome-platform-administration/page/administer/managing-
data/concept/c_Da

NEW QUESTION: 72
What are the two pathways to view feedback left on a published article?
A. Knowledge > articles > My Flagged
B. Knowledge base > my knowledge > flagged articles
C. Knowledge > My articles > Flagged
D. Knowledge > articles > published
Answer: B,C (LEAVE A REPLY)
InServiceNow Knowledge Management, users can providefeedbackonpublished knowledge
articlesby flagging them. This feedback helpsknowledge managers and authorsidentify errors,
outdated information, or areas for improvement.
Toview feedback left on a published article, there are two primary pathways:
Pathway 1: Knowledge Base > My Knowledge > Flagged Articles
This option allowsknowledge managers and authorsto see all flagged articlesthey have authored
or have access towithin a specificKnowledge Base.
Location:Knowledge Base # My Knowledge # Flagged Articles
Pathway 2: Knowledge > My Articles > Flagged
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This option lets authorsview only their own articlesthat have been flagged.
Location:Knowledge # My Articles # Flagged
A: Knowledge > Articles > My Flagged
There isno direct "My Flagged" optionunderKnowledge > Articles.
D: Knowledge > Articles > Published
This showsall published articlesbut doesnot specifically show flagged (feedback) articles.
Navigate toKnowledge > My Articles > Flagged.
OR navigate toKnowledge Base > My Knowledge > Flagged Articles.
Open a flagged article to review thefeedback comments and reason for the flagging.
ServiceNow Docs: Managing Knowledge Feedback and Flagged
Articleshttps://docs.servicenow.com/en-US
/bundle/utah-it-service-management/page/product/knowledge-management/task/review-article-
feedback.html ServiceNow CSA Official Training Guide (Knowledge Management & Feedback
Handling) Why the Other Options Are Incorrect?How to View Feedback in ServiceNow?
References from Certified System Administrator (CSA) Documentation:This confirms that the
correct pathways to view feedback on published articles are"Knowledge Base > My Knowledge >
Flagged Articles"and"Knowledge > My Articles
> Flagged".

NEW QUESTION: 73
ServiceNow contains a resource which provides the following:
A standard and shared set of service related definitions across ServiceNow products and platform
that will enable and support true service level reporting.
A CMDB framework across our products and platform that will enable and support multiple
configuration strategies.
What resource do these statements describe?
A. Common Services Data Model (CSDM)
B. Information Technology Service Management (ITSM)
C. Configuration Management Database (CMDB)
D. Information Technology Infrastructure Library (ITIL)
Answer: (SHOW ANSWER)
Reference:
https://www.servicenow.com/content/dam/servicenow-assets/public/en-us/doc-type/resource-
center/solution-brie

NEW QUESTION: 74
You are showing your customer a new form that you have created for their new application. They
would like to add a field to the form. Where could you do that? (Choose two.)
A. Select Fields and Columns module
B. Right click on form header, select Configure > Form Layout
C. Click on context menu, select Configure > Form Designer

https://www.exam-tests.com/CSA-exam/ServiceNow.CSA.v2025-08-07.q124.html


D. Select Field Class Manager module
Answer: (SHOW ANSWER)
Reference: https://docs.servicenow.com/bundle/rome-it-service-
management/page/product/change- management/task/t_CreateCustomField.html

NEW QUESTION: 75
The ServiceNow platform supports a wide variety of plus-and-play application. You can choose
from the included workflow or build your own workflow. Which of following these workflows are
included in the platform?
A. Manufacturing Workflows
B. Federal Workflows
C. Employee Workflows
D. Infrastructure Workflows
E. Customer Workflows
F. IT Workflows
Answer: C,E,F (LEAVE A REPLY)

NEW QUESTION: 76
How is a user defined in ServiceNow?
A. A user is 2 field in the LOAP integration
B. user is a record stored in the User Preference [Sys_user_preference] table
C. A user is a record stored in the User [sys_user] table
D. A User is a record stored in the Profile [sys_user_profile] table
Answer: B (LEAVE A REPLY)

Valid CSA Dumps shared by BraindumpsPass.com for Helping Passing CSA Exam!
BraindumpsPass.com now offer the newest CSA exam dumps, the BraindumpsPass.com
CSA exam questions have been updated and answers have been corrected get the
newest BraindumpsPass.com CSA dumps with Test Engine here:
https://www.braindumpspass.com/ServiceNow/CSA-practice-exam-dumps.html (502 Q&As

Dumps, 40%OFF Special Discount: Exam-Tests)

NEW QUESTION: 77
What are the three permission requirements that must evaluate to true for an access control rule
to apply?
Choose 3 answers
A. Conditions
B. table.
C. Roles
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D. table.none
E. table."
F. Script
Answer: (SHOW ANSWER)

NEW QUESTION: 78
Which three Variable Types can be added to a Service Catalog Item?
A. Number List, Single Line Text, and Reference
B. True/False, Multiple Choice, and Ordered
C. Multiple Choice, Select Box, and Checkbox
D. True/False, Checkbox, and Number List
Answer: C (LEAVE A REPLY)

NEW QUESTION: 79
ServiceNow is a single-instance, multiple tenant architecture?
A. False
B. True
Answer: A (LEAVE A REPLY)

NEW QUESTION: 80
Which SericeNow utility gives a Service Desk agent the ability to trace from a Service having an
issue, to see which Cis supporing that service have active issues?
A. Dependency View
B. Cl Health Dashboard
C. Event Management Homepage
D. AL Service Dashboard
Answer: B (LEAVE A REPLY)

NEW QUESTION: 81
Tables may have a One to Many relationships. From the Service Catalog, what are examples of
tables having a one to many relationships? (Choose three.)
A. One Approval can have many Requests
B. One Request can have many Requested Items
C. One Requested Item can have many Approvals
D. One Requested Item can have many Catalog Tasks
E. One Cart can have many Requests
Answer: B,C,D (LEAVE A REPLY)
In theServiceNow Service Catalog module, tables have aOne-to-Many (1:M) relationship,
meaning a single record in one table can relate to multiple records in another table. This is
especially important for handling Service Catalog requests, as multiple items, approvals, and
tasks may be associated with a single request.
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One Request can have many Requested Items (REQ # RITM)
ARequest (REQ)is a container for multipleRequested Items (RITM).
When a user submits a catalog request, multiple items (such as a laptop and a phone) can be
ordered in the same request.
Table Relationship:sc_request(Request) #sc_req_item(Requested Item)
One Requested Item can have many Approvals (RITM # Approval)
SomeRequested Items (RITM)require approval before being fulfilled.
For example, a laptop purchase might need approvals from both the IT department and a
manager.
Table Relationship:sc_req_item(Requested Item) #sysapproval_approver(Approval) One
Requested Item can have many Catalog Tasks (RITM # SCTASK) ARequested Item (RITM)can
generate multipleCatalog Tasks (SCTASK)for different fulfillment teams.
For example, if an employee requests a new laptop, one task might go to IT to set it up, while
another goes to finance for cost approval.
Table Relationship:sc_req_item(Requested Item) #sc_task(Catalog Task)
Breakdown of Correct Answers:Incorrect Answers Explanation:A.One Approval can have many
Requests Approvals do not relate to multiple requests. Instead, a request may contain multiple
approvals.
E:One Cart can have many Requests
TheCartis only a temporary storage of items before checkout. Once submitted, it generates
asingle Request (REQ), not multiple requests.
ServiceNow Product Documentation# "Understanding Service Catalog Tables and Relationships"
ServiceNow Data Model# "Request, Requested Item, and Catalog Task Relationships"
References from Certified System Administrator (CSA) Documentation:

NEW QUESTION: 82

An order from the Service Catalog has been placed. Two records in the Platform are created as a
result. Which two records are associated with tins newly ordered item?
Choose 2 answers
A. A change record
B. A problem record



C. A record of sc_task
D. An Incident record
E. A record of sc_req_llem table
Answer: C,E (LEAVE A REPLY)

NEW QUESTION: 83
Which icon would you double click, to expand and collapse the list of all Applications and
Modules?

A. Star
B. Clock
C. Application
D. Funnel
Answer: (SHOW ANSWER)
Reference: https://docs.servicenow.com/bundle/rome-platform-user-
interface/page/administer/navigation-and- ui/task/ui16-navigator-tasks.html

NEW QUESTION: 84
Which of the following statements is true when a new table is created by extending another table?
A. The new table archives the parent table and assumed its roles in the database
B. The new table inherits all of the Business Rules, Client Scripts, and UI Policies of the parent
table, but none of the existing fields
C. The new table inherits all of the fields of the parent table and can also contain new fields
unique to itself
D. The new table inherits all of the fields, but does not inherit Access Control rules, Client Scripts,
and UI Policies of the parent table
Answer: C (LEAVE A REPLY)
When a new table is created inServiceNowby extending another table, it followstable
inheritanceprinciples.
This means the newly created table (child table) receives all the fields from its parent table.
Additionally, the new table can includecustom fieldsthat are unique to itself.
Here's how inheritance works in ServiceNow when a table is extended:
Fields Inheritance:
The child table automatically inherits all fields from its parent table.
These inherited fieldscannot be removedfrom the child table but can be modified or overridden.
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The child table can also have additionalcustom fieldsthat do not exist in the parent table.
Business Rules, Client Scripts, and UI Policies:
Unlike fields, these components arenot automatically inherited.
However, they can still affect the child tableif they are defined on the parent table using conditions
that include the child table.
To apply them specifically to the child table, they need to beexplicitly definedfor the new table.
Access Control Rules (ACLs):
ACLs are not automatically inherited.
Each table in ServiceNow has its own set ofAccess Control Rules, which must be explicitly
configured for the child table if different permissions are required.
Database Structure:
The child table creates aone-to-one relationshipwith the parent table, meaningall fields in the
parent are available in the child table.
The new table is stored as a separate entity but references the parent table's structure.
The child tableinherits all fieldsfrom the parent table.
The child table can also have its owncustom fields.
Business Rules, Client Scripts, UI Policies, and ACLs arenot automatically inherited, meaning
options B and D are incorrect.
The tabledoes not archivethe parent table (making option A incorrect).
ServiceNow Product Documentation - Table Inheritance:https://docs.servicenow.com ServiceNow
Fundamentals - Table Relationships ServiceNow Developer Portal - Extending Tables
ServiceNow Best Practices - Access Controls & Security Rules Why Option C is Correct?
References from Certified System Administrator (CSA) Documentation:

NEW QUESTION: 85
What would you do, on a list, if you wanted to show the records in groups, based on the column
category?
(Choose two.)
A. On list Context Menu, select Group By > Category
B. On the Filter Menu, select Group By > Category
C. Click Group On icon, select Category
D. On Navigator Filter, type tablename.group.category and press enter
E. On the Category column title, click Context menu > Group By Category
Answer: A,E (LEAVE A REPLY)
In ServiceNow, lists allow users to view, filter, and group records dynamically. If you want to
group records based on a particular column (e.g.,Category), you can use the"Group
By"functionality.
A: On list Context Menu, select Group By > Category
TheList Context Menu(right-clicking anywhere in the list header) provides an option to group
records by a specific column.
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Selecting"Group By > Category"organizes records into expandable sections based on the
selected field.
This is one of the quickest ways to group records in a list.
E: On the Category column title, click Context menu > Group By Category Each column header in
a list has its ownColumn Context Menu(accessible by clicking the three-line menu or right-clicking
the column title).
Clicking"Group By Category"on theCategory columnwill instantly rearrange the list based on the
values in that column.
B: On the Filter Menu, select Group By > Category
TheFilter Menuis used for setting up filters and conditions, but it doesnotprovide a "Group By"
option.
It allows users to filter records but does not change the list structure.
C: Click Group On icon, select Category
There isno"Group On" icon in ServiceNow lists.
Grouping is done through context menus, not a dedicated "Group On" button.
D: On Navigator Filter, type tablename.group.category and press enter
TheApplication Navigator Filteris used for searching applications, modules, and tables-not for
modifying list views.
Entering something likeincident.group.categorywill not perform a grouping action on a list.
References:Official ServiceNow Documentation:Grouped Lists
ServiceNow User Interface Guide:List Control Features

NEW QUESTION: 86
A knowledge article must be which of the following states to display to a user?
A. Published
B. Drafted
C. Retired
D. Reviewed
Answer: A (LEAVE A REPLY)
InServiceNow Knowledge Management, knowledge articles must be in a specificstatebefore they
can be visible to end users. The correct state that allows users to view the article isPublished.
Understanding Knowledge Article StatesKnowledge articles in ServiceNow go through
alifecyclethat includes the following states:
Draft- The article is being created or edited and isnot visibleto end users.
Review- The article is under internal review by approvers before publication. It
remainshiddenfrom users.
Published- The article isapproved and publicly availableto users who have access to the
Knowledge Base.
Retired- The article is no longer relevant or has been replaced. It isnot visibleto end users.
OnlyPublishedarticles appear in the Knowledge Base and can be accessed by users.
Articles inDraft, Review, or Retiredstates arenot visibleto the general audience.
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B: Drafted- Articles inDraftare still being written or edited andcannot be accessed by users.
C: Retired- Retired articles are considered obsolete and areno longer displayedin the Knowledge
Base.
D: Reviewed- Articles inRevieware under approval butare not yet visibleto users.
ServiceNow Docs: Knowledge Article Stateshttps://docs.servicenow.com/en-US/bundle/utah-
servicenow- platform/page/product/knowledge-management/concept/knowledge-article-
states.html ServiceNow CSA Official Training Guide (Knowledge Management Lifecycle &
Publishing Workflow) Why is "Published" the Correct Answer?Why the Other Options Are
Incorrect?References from Certified System Administrator (CSA) Documentation:This confirms
that aknowledge article must be in the
"Published" stateto be visible to users in the Knowledge Base.

NEW QUESTION: 87
Which one of the following describes the primary operations performed against tables in the
Service Now platform?
A. Create, Rate, Update, Delete
B. Create, Read, Upload, Delete
C. Create, Read, Write, Delete
D. Capture, Rate, Write, Develop
Answer: (SHOW ANSWER)

NEW QUESTION: 88
A form displays information about one record at the top, for example a User, Additional records,
which are associated with that User, are displayed on tabs at the bottom of the form. What are
those tabs called?
A. Additional Info
B. More Info
C. Related Links
D. Related Lists
Answer: D (LEAVE A REPLY)
InServiceNow, when viewing a record in aform view, thetop sectionof the form displaysdetails
about that record, while thebottom section(if enabled) displaysrelated records that are associated
with it.
These sections at the bottom of the form are calledRelated Lists.
Displays Records from Related Tables
Related Lists showone-to-manyormany-to-manyrelationships between records.
Example: On aUserform, Related Lists might include:
Groups(shows all groups the user belongs to)
Roles(lists roles assigned to the user)
Incidents Assigned(shows all incidents assigned to the user)
Automatically Generated Based on Table Relationships
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ServiceNow automatically generates Related Lists based onReference Fields, Many-to-Many
(M2M) tables, or Database Views.
Admins canconfigure which Related Lists appearviaForm Layoutsettings.
Configurable in Form Design & UI Policies
Related Lists can beenabled or disabledusing:
Form Layout(Configure # Related Lists)
UI PoliciesandClient Scripts
Key Characteristics of Related Lists:
A: Additional InfoIncorrect- There is no "Additional Info" feature in ServiceNow related to form
layouts.
B: More InfoIncorrect- This is not a term used in ServiceNow for displaying related records.
C: Related LinksIncorrect-Related Linksprovidequick actions(e.g., "Create New Task") but
donotdisplay related records.
Incorrect Answer Choices Analysis:
ServiceNow Docs - Related Lists#Related Lists Overview
ServiceNow Docs - Configuring Related Lists on Forms#How to Configure Related Lists Official
ServiceNow Documentation References:

NEW QUESTION: 89
On what part of the ServiceNow instance, would you find the option to Impersonate User?
A. Module
B. Content Frame
C. Application Navigator
D. User Menu
Answer: (SHOW ANSWER)
In ServiceNow, anUpdate Setis a mechanism used to package and transfer customizations from
one instance to another. TheDefault Update Setis automatically created for every instance and
captures all unassigned configuration changes. However, it is considered abest practice not to
use the Default Update Set for moving customizations between instances.
Lack of Organization & Traceability
The Default Update Set collects all modifications automatically, making it difficult to track specific
changes related to a particular project or feature.
If multiple administrators or developers work in an instance, their changes will all be mixed
together in the Default Update Set, leading to confusion and conflicts.
Risk of Losing Changes
Default Update Sets are not automaticallycomplete. Since users can forget to mark their
customizations explicitly for an update set, some changes might not get captured.
If a system admin forgets to move a customization into a named update set, those changes may
not be included in the migration process.
Cannot Be Moved Between Instances
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The Default Update Setcannot be retrieved or movedbetween instances because it is system-
managed. This makes itimpossibleto use it for transferring customizations effectively.
Named Update Sets, on the other hand, allow developers to package only the required changes
for controlled migration.
Best Practice: Use Named Update Sets
It is highly recommended to create anamed Update Set(e.g.,
"Incident_Enhancements_Q1_2025") for each set of related changes.
This provides a structured way to track, test, and promote configurations fromdevelopment # test
# production environmentsin a controlled manner.
A: Merge Default Update Sets before moving between instancesIncorrect - The Default Update
Set cannot be moved between instances, so merging it would not serve any purpose.
B: Submit Default Update Set to Application RepositoryIncorrect - The Application Repository is
used forScoped Applications, not for update sets. The Default Update Set is system-managed
and should not be used for structured deployments.
D: Keep Default Update Set to a maximum of 20 records, for troubleshooting purposesIncorrect -
While keeping the Default Update Set small might be useful for tracking small changes, there is
no such best practice limit of "20 records." It is still not recommended for migrations.
ServiceNow Product Documentation - Update Sets Best Practices#Update Set Best Practices
ServiceNow Community Best Practices - Managing Update Sets#Managing Update Sets
Reasons Why You Should Not Use the Default Update Set for Moving Between
Instances:Incorrect Answer Choices Analysis:Official ServiceNow Documentation
References:Conclusion:The correct answer isC. You should not use the Default Update Set for
moving between instances.The best practice is to always createnamed Update Setsto ensure
controlled, traceable, and reliable migrations of customizations between ServiceNow instances.

NEW QUESTION: 90
Groups are stored in what table?
A. Group [sys_user_group]
B. Group [sn_sys_user_group]}
C. User Group [user_groups]
D. User Groups [sn_user_groups]
E. Groups [sys_user_groups]
Answer: A (LEAVE A REPLY)
In ServiceNow,groupsare stored in thesys_user_grouptable. This table definesgroups of
userswho share common responsibilities, such asIT support teams, HR teams, or security teams.
Groups are used toassign roles and permissionsto multiple users at once.
Common groups includeService Desk, IT Support, Change Advisory Board (CAB), and HR
teams.
Thesys_user_grouptable is linked tosys_user(Users) andsys_user_role(Roles).
B: Group [sn_sys_user_group]- No such table prefix (sn_) exists for user groups in ServiceNow.
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C: User Group [user_groups]- Incorrect table name; ServiceNow follows thesys_naming
convention.
D: User Groups [sn_user_groups]- Not a valid ServiceNow table.
E: Groups [sys_user_groups]- Incorrect pluralization; ServiceNow tables typically usesingular
names(e.g., sys_user_group).
ServiceNow sys_user_group Table Documentation
ServiceNow CSA Training Module:"User and Group Administration"
Key Details about sys_user_group:Why Other Answers Are Incorrect:References from Certified
System Administrator (CSA) Official Documentation:

NEW QUESTION: 91
A Service Catalog may include which of the following components?
A. Order Guides, Exchange Rates, Calendars
B. Order Guides, Catalog Items, and Interceptors
C. Catalog Items, Asset Contracts, Task Surveys
D. Record Producers, Order Guides, and Catalog Items
Answer: D (LEAVE A REPLY)
In ServiceNow, theService Catalogis a structured collection of IT and business services that users
can request.
It is designed to provide a self-service experience for end-users, streamlining service requests
and automating fulfillment processes. The main components of a Service Catalog include:
Record Producers- These are simplified forms that allow users to create records in various tables
without requiring direct access to those tables. They enable users to submit requests or incidents
through the catalog in a user-friendly manner.
Order Guides- These facilitate the ordering of multiple related catalog items in a single request.
For example, when a new employee is onboarded, an order guide can group multiple items such
as a laptop, software access, and a phone.
Catalog Items- These are the individual items or services that users can request through the
Service Catalog.
Examples include hardware (like laptops and monitors), software access, and other business
services.
Option A (Order Guides, Exchange Rates, Calendars)-
Exchange RatesandCalendarsare not part of the Service Catalog framework in ServiceNow.
While Exchange Rates may be relevant in financial applications, they do not define the core
components of the Service Catalog.
Calendars are used for scheduling, but they do not form part of the Service Catalog structure.
Option B (Order Guides, Catalog Items, and Interceptors)-
Interceptorsare used to guide users through form-based submissions, but they are not a
fundamental component of the Service Catalog.
Order Guides and Catalog Items are correct, but the presence of Interceptors makes this option
incorrect.
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Option C (Catalog Items, Asset Contracts, Task Surveys)-
Asset Contractsrelate to IT Asset Management (ITAM) and are not core Service Catalog
components.
Task Surveysare used for feedback collection but are not part of the core structure of a Service
Catalog.
References:ServiceNow CSA Documentation: Service Catalog Overview
ServiceNow CSA Learning Path: Service Catalog Fundamentals
ServiceNow Product Documentation: Order Guides & Record Producers

Valid CSA Dumps shared by BraindumpsPass.com for Helping Passing CSA Exam!
BraindumpsPass.com now offer the newest CSA exam dumps, the BraindumpsPass.com
CSA exam questions have been updated and answers have been corrected get the
newest BraindumpsPass.com CSA dumps with Test Engine here:
https://www.braindumpspass.com/ServiceNow/CSA-practice-exam-dumps.html (502 Q&As

Dumps, 40%OFF Special Discount: Exam-Tests)

NEW QUESTION: 92
How can an administrator modify the layout of a form using Table Builder?
A. By configuring form sections
B. By changing the database schema
C. By editing system scripts
D. By altering the page header theme
Answer: (SHOW ANSWER)
Table Builder is a ServiceNow feature that allows administrators to modify table structures,
configure forms, and manage relationships within a visual interface.
When modifying form layouts in Table Builder, administrators can:# Add, remove, or rearrange
fields on the form.# Create new form sections to organize fields logically.# Configure default
values and field properties.# Manage related lists and relationships between tables.
* Option B (Changing the database schema) is incorrect because modifying form layouts does not
require schema changes (though Table Builder can modify schemas, it's not necessary for layout
changes).
* Option C (Editing system scripts) is incorrect because form layout changes do not require
scripting.
* Option D (Altering the page header theme) is incorrect because themes affect the UI
appearance, not form structure.
# Reference: ServiceNow Platform Fundamentals - Table Builder & Form Configuration

NEW QUESTION: 93
What is a no-code approach to control the mandatory or read-only state of a form field?
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A. UI RuIe
B. UI Policy
C. UI Action
D. Client Script
E. UI Script
Answer: B (LEAVE A REPLY)

NEW QUESTION: 94
When you need to orchestrate business processes across services with little technical user
knowledge, which utility would you use?
A. Flow Manager
B. Flow Designer
C. Flow Editor
D.Workflow Editor
E.Workflow Designer
Answer: B (LEAVE A REPLY)
Flow Designeris ano-code/low-codeautomation tool in ServiceNow that enables users
toorchestrate business processes across different serviceswith minimal technical knowledge. It
allowsnon-technical usersto build complex workflows using drag-and-drop functionality.
No-Code/Low-Code Automation
Users candesign, test, and managebusiness processeswithout coding skills.
Actions can be executedsequentially or conditionallybased on logic.
Integration with ServiceNow Applications
Flow Designer works withIntegrationHub, allowing ServiceNow to interact with external systems
like Slack, Microsoft Teams, and Jira.
Trigger-Based Execution
Flows can be triggeredby conditions, schedules, or user actions.
Prebuilt Spokes & Actions
ServiceNow providesprebuilt "Spokes"with reusable actions that simplify workflow automation.
A: Flow Manager(Incorrect)
No such module called "Flow Manager" exists in ServiceNow.
C: Flow Editor(Incorrect)
The term "Flow Editor" is not used in ServiceNow; the correct name isFlow Designer.
D: Workflow Editor(Incorrect)
Workflow Editoris part of the olderLegacy Workflow Engine, which requires scripting and is not
recommended for no-code automation.
E: Workflow Designer(Incorrect)
This is not an official ServiceNow tool; Flow Designer has replaced older workflow tools for
modern automation needs.
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Flow Designer Overview:https://docs.servicenow.com/en-US/bundle/utah-
automation/page/administer/flow- designer/concept/flow-designer.html Building Flows in Flow
Designer:https://docs.servicenow.com/en-US/bundle/utah-automation/page/administer
/flow-designer/task/t_CreateFlow.html
Key Features of Flow Designer:Explanation of Incorrect Options:Official References from Certified
System Administrator (CSA) Documentation:

NEW QUESTION: 95
Which one of the following statements describes the purpose of a Service Catalog workflow?
A. A Service Catalog workflow generates three basic components: item variable types, tasks, and
approvals
B. A Service Catalog workflow generates three basic components: item variable types, tasks, and
notifications
C. Although a Service Catalog workflow cannot send notifications, the workflow drives complex
fulfillment processes
D. A Service Catalog workflow is used to drive complex fulfillment processes and sends
notifications to defined users or groups
Answer: (SHOW ANSWER)

NEW QUESTION: 96
After finishing your work on High Security Settings, what is a possible way to return to normal
admin security levels?
A. Use System Administration > Normal Security module
B. End impersonation
C. Select Global Update Set
D. Select Normal role
E. Log out and back in
Answer: (SHOW ANSWER)

NEW QUESTION: 97
What are the 5 provided Roles by ServiceNow?
A. System Administrator: The admin role provides access to all platform features, applications,
functions and data.
B. Specialized Administrator: Specialized administrator roles manage specific functions or
applications, such as Assignment Rules, Knowledge base, reports, or web services
C. Fulfiller: Users with the ITIL role may fulfill ITIL activities associated with the ITIL workflow,
including Incident and Change management.
D. Approver: Users with the Approver user role can perform all requester actions and may view or
modify approval records directed to the approver
E. Requester: Also known as Employee Self Service (ESS) users, these users have no roles but
can submit and manage their own requests, access public pages, etc.
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Answer: A,B,C,D,E (LEAVE A REPLY)
ServiceNow providesfive primary rolesthat define access and permissions within the platform.
These roles help structure user responsibilities and ensure that users only have access to the
necessary functions.
Thehighest level of accessin ServiceNow.
Can manage all platform features, applications, data, and configurations.
Has control overusers, security settings, system properties, and scripting capabilities.
Example: A ServiceNow admin configuring new workflows, modifying tables, or setting up
instance-wide settings.
Manages specific applications or functionalities within ServiceNow.
Includes roles such as:
knowledge_admin(Manages Knowledge Base)
report_admin(Manages Reports)
catalog_admin(Manages Service Catalog)
Example: A Knowledge Base Administrator controlling access to articles and updating knowledge
categories.
Users with theITIL rolewho perform IT Service Management (ITSM) tasks.
Cancreate, update, and resolve recordssuch as incidents, problems, changes, and requests.
Example: A service desk agent handling incidents and requests.
Users with theApprover rolecanapprove or reject requests, such as change requests or access
requests.
Can view or modify approval records directed to them but cannot fulfill other ITIL tasks.
Example: A manager approving a new software installation request.
Basic userswith no assigned roles.
Cansubmit requests, view their own tickets, and access public pages(e.g., Knowledge Base,
Catalog).
Example: An employee submitting a request for laptop repair via the ServiceNow portal.
1. System Administrator (admin)2. Specialized Administrator3. Fulfiller (ITIL Role)4. Approver5.
Requester (Employee Self-Service - ESS) These roles form thefoundation of role-based access
control (RBAC)in ServiceNow.
They ensure that usersonly access the data and functions relevant to their job responsibilities.
Additional roles can be assigned based on business needs, but these five cover the core platform
functionalities.
Why These Are the Provided Roles in ServiceNow:
ServiceNow Documentation:User Roles in ServiceNow
CSA Exam Guide:CoversSystem Administrator, Specialized Administrator, Fulfiller, Approver, and
Requesteras the standard user roles.
Reference from CSA Documentation:Thus, the correct answer is:
A: System Administrator, B. Specialized Administrator, C. Fulfiller, D. Approver, E. Requester

NEW QUESTION: 98
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Which one of the following is an accurate list of changes that are captured in an Update Set?
A. Changes made to tables, forms, schedules, and client scripts
B. Changes made to tables, forms, views, and fields
C. Changes made to: tables, forms. Business Rules, and data records
D. Changes made to: tables. forms groups, and configuration items (Cls)
Answer: A (LEAVE A REPLY)
AnUpdate SetinServiceNowis a mechanism for capturing and migratingcustomizations and
configurationsfrom one instance to another (e.g.,Development # Test # Production).
What is Captured in an Update Set?Update Sets recordconfiguration changes, such as:
Tables & Database Schema Changes(e.g., new tables, modified fields)
Form Layout & UI Changes(e.g., changes in form views, UI policies)
Schedules(e.g., Scheduled Jobs, Business Rules with scheduled actions)
Client Scripts(e.g., JavaScript running on the client side)
Business Rules, UI Actions, UI Policies
Workflows, Script Includes, ACLs (Access Control Rules)
Email Notifications, Dictionary Entries, Application Menus
What is NOT Captured in an Update Set?Data Records (e.g., Incident, Change Request, CMDB
data) Group Memberships & User Data System Properties (some properties may require manual
migration) Attachments & Scheduled Reports B: Changes made to tables, forms, views, and
fields(Incorrect) Views and Fieldsare part of UI changes, butschedules and client scriptsare also
included in Update Sets, makingOption A more complete.
C: Changes made to tables, forms, Business Rules, and data records(Incorrect) Data records
(actual table entries like incidents or change requests) are NOT captured in Update Sets.
D: Changes made to tables, forms, groups, and configuration items (CIs)(Incorrect) Groups and
CIs (CMDB data) are considered data and are NOT included in Update Sets.
Instead,CIs should be migrated using Import Sets or CMDB data export/import.
Why Other Options Are Incorrect?
Understanding Update Sets
Update Sets Overview
What Gets Captured in Update Sets?
Best Practices for Using Update Sets
References from ServiceNow CSA Documentation:

NEW QUESTION: 99
A colleague wants to rearrange the columns on their My Work list. Once the user has navigated
to the list where should they navigate to select and arrange the columns?
A. Click Personalize List
B. Right click on any column header. Context Menu > Configure > List Layout
C. Click List Context Menu > Personalize List
D. Click List Content Menu > Configure > List Layout
Answer: B (LEAVE A REPLY)
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To rearrange the columns on a list, users can right click on any column header and select
Configure > List Layout from the context menu2. This will open a dialog box where users can
select the available fields and move them to the selected list using the arrow buttons2. Users can
also drag and drop the fields to change the order of the columns2.
References
* How To Configure List and Form Layouts | by ServiceNow Scholar - Medium2

NEW QUESTION: 100
Which section of the ServiceNow UI allows you to perform a global search?
A. Content frame
B. Banner frame
C. Application Navigator
D. List pane
Answer: B (LEAVE A REPLY)

NEW QUESTION: 101
What is the purpose of flagging an article in a knowledge base?
A. To mark an article to read later.
B. Allow a user to submit feedback about an article
C. Reporting an error
Answer: (SHOW ANSWER)
InServiceNow Knowledge Management,flagging an articleis a feature that allows users toreport
errors or issueswithin a knowledge article. This helps maintain article accuracy and ensures that
outdated or incorrect information is addressed by knowledge managers.
Error Reporting
Users can flag an article if they findincorrect, outdated, or misleading information.
Knowledge managers receive anotificationabout flagged articles and can review them for
updates.
Article Quality Control
Helps improve knowledge base content by allowing users topoint out inaccuracies.
Ensures that knowledge articles remainrelevant and useful.
Notifying Knowledge Managers
Flagged articles appear in theKnowledge Base Administration module, allowing managers totrack
and resolve flagged issues.
A: To mark an article to read later
Incorrect: There isnobuilt-in "read later" feature in ServiceNow Knowledge Management.
Instead, users canbookmarkan article for quick access.
B: Allow a user to submit feedback about an article
Incorrect:
Feedback is submitted through theFeedback feature, which allows users to rate articles and
provide comments.
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Flaggingis specifically forerror reporting, not general feedback.
Key Purposes of Flagging an Article:Why Other Options Are Incorrect?
Flagging Knowledge Articles
Flagging an Article for Review
Managing Flagged Articles
Knowledge Management Administration
References from ServiceNow CSA Documentation:

NEW QUESTION: 102
Two departments (HR Onboarding and Facilities) have come to you, asking for a way for
employees to request event room set up services. The requirements are the same for the form
and the task routing to the Facilities' assignment group.
For HR, the item will be used primarily for the Onboarding coordinators, for employee orientation
sessions.
For Facilities, the item will be used for anyone in the company who needs room set up services.
However, both departments have their own service catalogs. What do you do, to support these
requirements?
A. Create one Catalog Item for HR Event Room Set Up and one for Facilities Event Room Set
Up; then publish each to the appropriate Catalog.
B. Create one Catalog Item for Event Room Set Up; then publish to both Catalogs.
C. Create one Catalog Item for Event Room Set Up; then publish to the Parent Catalog, which is
accessible to both HR and Facilities.
D. Create one Catalog Item for Event Room Set Up; then use ACLs to control access.
Answer: B (LEAVE A REPLY)
ServiceNow allowsa single Catalog Itemto be published tomultiple service catalogs, avoiding
duplication while ensuring accessibility for the right users.
Instead ofcreating duplicate catalog items(which would require managing two separate items with
the same functionality), we createone Catalog Itemandpublish it in both catalogs (HR and
Facilities).
This approach ensurescentralized managementwhile maintaining accessibility for both
departments.
It simplifies updates-any changes to the form or workflow will apply toboth catalogs automatically.
Why is Option B Correct?
Why Are the Other Options Incorrect?A. Create one Catalog Item for HR Event Room Set Up and
one for Facilities Event Room Set Up; then publish each to the appropriate Catalog.
Incorrectbecause it createsduplicate catalog itemswith thesame functionality, increasing
maintenance effort.
C: Create one Catalog Item for Event Room Set Up; then publish to the Parent Catalog, which is
accessible to both HR and Facilities.
Incorrectbecausethere is no "Parent Catalog" conceptin ServiceNow.
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ServiceNow allowspublishing a single item to multiple catalogs, but there is no need for aparent
catalog.
D: Create one Catalog Item for Event Room Set Up; then use ACLs to control access.
Incorrectbecause ACLsrestrict access at a field, table, or record level, but theydo not control
where a Catalog Item appears.
Thecorrect approachis topublish the item to multiple catalogsrather than using ACLs.
ServiceNow Service Catalog Management - Publishing Items to Multiple Catalogs ServiceNow
ITSM - Best Practices for Catalog Item Reusability ServiceNow CSA Guide - Managing Service
Catalogs and Items References to Official Certified System Administrator (CSA) Documentation:

NEW QUESTION: 103
What is the difference between a UI Policy and Data Policy?
A. Data Policies run only after UI Policies run successfully
B. Data Policies run when data is entered through the form, by an Import Set, or by web services,
while UI Policies are set only by web services
C. Data Policies run regardless of how data is entered into ServiceNow, while UI Policies are
used for form interactions
D. Data Policies can be converted into UI Policies, but UI Policies cannot be converted into Data
Policies
Answer: C (LEAVE A REPLY)

NEW QUESTION: 104
Which statement is true about business rules?
A. A business rule must run before a database action occurs
B. A business rule must not run before a database action occurs
C. A business rule monitors fields on a form
D. A business rule can be a piece of Javascript
Answer: D (LEAVE A REPLY)

NEW QUESTION: 105
What icon do you use to change the boon and color on a Favorite?
A. Pencil
B. Star
C. Clack
D. Tringle
Answer: A (LEAVE A REPLY)
InServiceNow, thePencil (#) iconis used toeditandcustomizeFavorites in theApplication Navigator.
Open theApplication Navigator.
Locate theFavoritessection.
Click thePencil (#) iconnext to the favorite you want to edit.
Choose anew iconandcolor.
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ClickSaveto apply changes.
B: Star
TheStar iconis used toadd or removea favorite,not editit.
C: Clock
TheClock iconrepresentsRecently Viewed items, not Favorites customization.
D: Triangle
NoTriangle iconis used for modifying Favorites in ServiceNow.
Reference:ServiceNow CSA Documentation - Customizing Favorites
ServiceNow Product Documentation - Personalizing the Application
Navigator(https://docs.servicenow.com)

NEW QUESTION: 106
Which type of interface enables you to display multiple performance analytics, reporting and other
widgets on
a single screen?
A. Dashboard
B. Form
C. Timeline
D. List
Answer: A (LEAVE A REPLY)

Valid CSA Dumps shared by BraindumpsPass.com for Helping Passing CSA Exam!
BraindumpsPass.com now offer the newest CSA exam dumps, the BraindumpsPass.com
CSA exam questions have been updated and answers have been corrected get the
newest BraindumpsPass.com CSA dumps with Test Engine here:
https://www.braindumpspass.com/ServiceNow/CSA-practice-exam-dumps.html (502 Q&As

Dumps, 40%OFF Special Discount: Exam-Tests)

NEW QUESTION: 107
On what part of the ServiceNow instance, would you find he option to impersonate User?
A. Module
B. Content Frame
C. User Menu
D. Application Navigator
Answer: C (LEAVE A REPLY)

NEW QUESTION: 108
Which icon would you double click, to expand and collapse the list of all Applications and
Modules?
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A. Star
B. Clock
C. Application
D. Funnel
Answer: C (LEAVE A REPLY)
Reference:
https://docs.servicenow.com/bundle/rome-platform-user-interface/page/administer/navigation-
and-ui/task/ui16-n

NEW QUESTION: 109
What is a quick way to create a report from a list view?
A. Click on filter breadcrumb, drag and drop on the Report > Create New module
B. Click Funnel, define filter conditions, click Create Report
C. Click Context Menu, select Create Report
D. Apply filter, right click on column header, select Bar Chart
E. Apply filter, right click on column header, select Create Report
Answer: (SHOW ANSWER)
In ServiceNow, users can quickly generate a report from a list view without needing to navigate to
the Reports module. The two main ways to do this are:
Steps:
Open any list view (e.g., Incident, Change, or any table-based list).
Click thethree-line (hamburger) context menuon the top-left of the list.
SelectCreate Reportto generate a basic report based on the current list view.
Modify report settings (e.g., visualization type, filters, groupings).
Save the report for future reference.
Steps:
Apply the necessary filters to refine the list view.
Right-click on acolumn header(e.g., Priority, State, Category).
SelectCreate Reportfrom the context menu.
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Configure the report visualization and save it if needed.
1. Using the Context Menu (Option C)2. Right-click on a Column Header (Option E) Incorrect
Answer Choices Explanation:A. Click on filter breadcrumb, drag and drop on the Report > Create
New module There is no such drag-and-drop functionality for report creation in ServiceNow.
B: Click Funnel, define filter conditions, click Create Report
TheFunnel iconis used to filter list views but does not directly generate reports.
D: Apply filter, right-click on column header, select Bar Chart
There is no direct "Bar Chart" option available when right-clicking on a column header.
Creating Reports from List Views
ServiceNow KB Article: KB0014148
Official CSA Documentation Reference: https://ut.service-now.com/sp?
id=kb_article&number=KB0014148

NEW QUESTION: 110
What are benefits of assigning work tasks to a group, rather than to an individual? (Choose four.)
A. Group members can choose their tasks from My Groups Work
B. Groups can assign tasks to users based on skills
C. Groups can assign tasks to users based on on-call schedules
D. Group members can avoid tasks, which are nearing SLA breach
E. Groups can assign tasks to users based on availability
F. Site support members can pick tasks, based on Location
Answer: (SHOW ANSWER)

NEW QUESTION: 111
What information does the System Dictionary contain?
A. The human-readable labels and language settings
B. The definition for each table and column
C. The information on how tables relate to each other
D. The language dictionary used for spell checking
Answer: B (LEAVE A REPLY)
TheSystem Dictionaryin ServiceNow stores and maintains themetadataabout tables and fields in
the platform.
It containsdefinitions for each table and column, including field data types, default values, and
attributes.
Storestable and field definitions, including:
Column names
Data types(e.g., String, Integer, Reference)
Attributes(e.g., unique, read-only, required)
Default values
Ensuresdata integrityby defining the structure of database tables.
Used by administrators tomodify or extend existing tables.
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Allows the creation ofcustom fieldsin tables.
Key Features of the System Dictionary (sys_dictionaryTable):
Navigate to:System Definition # Dictionary
Search for a table or fieldto view its metadata.
Modify attributes(if needed) to customize table behavior.
How to Access the System Dictionary:
A: The human-readable labels and language settings- Incorrect.
Human-readable labelsare stored in thesys_documentationtable, not the System Dictionary.
C: The information on how tables relate to each other- Incorrect.
Table relationshipsare stored in theSchema Map, not the System Dictionary.
D: The language dictionary used for spell checking- Incorrect.
Spell checking and translationsare managed insystem localization settings, not the System
Dictionary.
Explanation of Incorrect Answers:
ServiceNow Product Documentation # System Dictionary (sys_dictionary)
ServiceNow CSA Study Guide # Understanding Tables and Fields
ServiceNow Developer Documentation # Dictionary and Table Structure
References from Certified System Administrator (CSA) Documentation:Would you like me to
verify another question?#

NEW QUESTION: 112
What is the definition of a group?
A. A team of users
B. An escalation pod
C. A department
D. A collection of subject matter experts
E. A collection of users
Answer: (SHOW ANSWER)

NEW QUESTION: 113
What do you call any component that needs to be managed in order to deliver services?
A. CSDM Items
B. CMDB
C. Configuration item
D. Service Offerings
E. Asset
Answer: (SHOW ANSWER)
Reference: https://infocenter.io/servicenow-cmdb-implementation/

NEW QUESTION: 114
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What module enables an administrator to define destinations for imported data on any
ServiceNow table?
A. Field Transform
B. Transform Map
C. Schema Map
D. Import Map
Answer: B (LEAVE A REPLY)
ATransform Mapin ServiceNow is used to define howimported datafrom external sources (such
as CSV files, Excel sheets, or third-party integrations) is mapped into thetarget tablewithin the
platform.
They allowadministratorsto definefield mappingsbetween theimport set tableand thetarget table.
Can includefield transformations, such as converting data formats or merging values.
Supportscriptedtransformations usingonBefore and onAfter scripts.
A: Field Transform- No such module exists in ServiceNow. Transform Maps handle field
transformations.
C: Schema Map- The Schema Mapvisualizestable relationships but doesnothandle data imports.
D: Import Map- This isnot a valid ServiceNow module. The correct term isTransform Map.
ServiceNow Transform Maps Documentation
ServiceNow CSA Training Module:"Importing Data and Transform Maps"
Key Features of Transform Maps:Why Other Answers Are Incorrect:References from Certified
System Administrator (CSA) Official Documentation:

NEW QUESTION: 115
What capability allows users to create dashboards with widgets to visualize data over time in
order to identify areas of improvement?
A. Scheduled Reports
B. Analytics Reports
C. Reporting
D. Performance Analytics
Answer: D (LEAVE A REPLY)

NEW QUESTION: 116
Which of the following is used to initiate a flow?
A. An Event
B. A Trigger
C. A spoke
D. Core Action
Answer: (SHOW ANSWER)

NEW QUESTION: 117
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Your customer requires that they be able to monitor which users are performing impersonations in
their instance. What would you do to meet that requirement?
A. Add the role Log Write [sn_log_write] to the Impersonator Group
B. Create user update set for impersonation tracking
C. Activate the glide.sys.log_impersonation prop
D. From User icon, select Elevate Roles
E. On the Impersonator role record, right click and select Create Log
Answer: (SHOW ANSWER)
Reference https://support.servicenow.com/kb?id=kb_article_view&sysparm_article=KB0717055

NEW QUESTION: 118

Which path would you take to access the table configuration page from a form?
A. The Form Context menu > Configure > Dictionary
B. The Form Context menu > View > Show Table
C. The Form Context menu > View > Table
D. The Form Context menu > Configure > Table
Answer: D (LEAVE A REPLY)

NEW QUESTION: 119
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Which feature can be used to categorize a set of records from a list and make them visible to
other users?
A. Tags
B. History
C. Favorites
D. Activity Formatter
Answer: (SHOW ANSWER)
In ServiceNow,Tagsallow users tocategorize and grouprecords in a list. Tagged records arevisible
to othersif set to public or shared with specific users or groups.
A: Tags
Tags help usersorganize and quickly locaterecords.
Tags can beprivate (Me)orshared (Everyone, Groups, or Specific Users).
Example:
A support team might tagcritical incidentswith "Urgent" for easy tracking.
B: History
TheHistorymodule showsrecently accessed recordsbut does not categorize or share records.
C: Favorites
Favoritesallow users tobookmark specific records or listsfor quick access, but they areprivateand
not shared with others.
D: Activity Formatter
TheActivity Formattertrackschanges and updatesin a record (e.g., who modified the record,
comments added), but it does notcategorize or sharerecords.
References:ServiceNow Documentation:Using Tags in Lists
ServiceNow User Guide:Managing and Sharing Tags

NEW QUESTION: 120
What do you click when you have made modification to your report, and your want to see the
results without saving?
A. Execute
B. Try ir
C. Run
D. Test
E. Preview
Answer: (SHOW ANSWER)
InServiceNow Reporting, when modifying a report, users can preview the resultswithout savingby
clicking the"Run"button. This executes the report with the current settings and displays the
updated resultsbefore committing any changes.
C: Run
The"Run"button allows users toexecute the report immediatelyto see updated results.
It helps users verify if filters, conditions, or visualizations are correctbefore saving the report.
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Example: If a user changes thedate rangeon anincident report, clicking"Run"updates the
chartwithout saving the report permanently.
A: Execute
There isno "Execute" buttonin ServiceNow Reporting.
"Execute" is used in scripting (e.g., Business Rules, Scheduled Jobs), not for reports.
B: Try it
Not a valid option in ServiceNow Reporting.
Possibly confused with"Try It" in Flow Designeror Catalog Items.
D: Test
"Test" is used inWorkflows, Business Rules, and Flow Designer, not in reports.
E: Preview
There isno "Preview" buttonfor running reports.
"Preview" is typically used inUI Policies and Forms.
References:ServiceNow Documentation:Creating and Running Reports
ServiceNow Reporting Guide:Modifying Reports in Report Designer

NEW QUESTION: 121
On the Form header, which icon do you use to access form templates?
A. Paperclip
B. Pages
C. Stamp
D. More Options {...)
Answer: C (LEAVE A REPLY)
InServiceNow, theStamp icon (#)in theForm Headeris used to accessForm
Templates.Templatesallow users to quickly populate fields in a form withpredefined values,
improving efficiency and consistency.
Open arecord form(e.g., Incident, Change, or Request form).
Click theStamp (#) iconin the form header.
Select atemplatefrom the list.
The form fields will bepre-filledwith the template's values.
A: Paperclip
ThePaperclip iconis used toattach filesto a record, not access templates.
B: Pages
NoPages iconis used for templates in ServiceNow.
D: More Options{...}
TheMore Options menuprovides access to additionalrecord actions, but templates are accessed
using theStamp icon.
Reference:ServiceNow CSA Documentation - Using Form Templates
ServiceNow Product Documentation - Creating & Applying Form
Templates(https://docs.servicenow.com)
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NEW QUESTION: 122
The ServiceNow Virtual Agent provides assistance within a messaging interface. Which capability
allows end users to configure virtual Agent to intercept and help resolve submitted incidents?
A. Ticket Resolver
B. Incident Auto-Resolution
C. Virtual Agent Helper
D.Web Intelligence
Answer: B (LEAVE A REPLY)

NEW QUESTION: 123
What are the benefits of building flows using Flow Designer? Choose 3 answers
A. Supports easy integration with 3rd party systems
B. Provides IDE for complicated scripting
C. Provides natural-langauge descriptions of flow logic
D. Supports No-Code application development
E. Automatically populates SLA records
F. Provides built-in libraries /API for complex coding
Answer: A,C,D (LEAVE A REPLY)
The following are the benefits of building flows using Flow Designer:
* C. Provides natural-language descriptions of flow logic: This allows users without programming
experience to understand and modify flows, making them more accessible to a wider range of
users.
* D. Supports No-Code application development: Flow Designer provides a visual interface and
pre-built actions that allow users to automate processes without writing code. This can
significantly reduce development time and effort.
* A. Supports easy integration with 3rd party systems: Flow Designer integrates with a variety of
3rd party systems through the Integration Hub, making it easy to connect your ServiceNow
instance to external applications.
Flow Designer offers a low-code/no-code approach to building automation, simplifies complex
logic with natural language descriptions, and integrates seamlessly with external systems.
References:

https://www.braindumpspass.com/ServiceNow/CSA-practice-exam-dumps.html
https://www.exam-tests.com/CSA-exam/ServiceNow.CSA.v2025-08-07.q124.html
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* ServiceNow Product Documentation: Exploring Flow Designer -
https://docs.servicenow.com/bundle
/sandiego-application-development/page/administer/flow-designer/concept/flow-designer.html
* ServiceNow Community: Flow Designer vs Workflow - https://www.servicenow.com/community
/developer-forum/what-are-the-advantages-and-disadvantages-between-flow-designer/m-
p/1407094

NEW QUESTION: 124
Which ServiceNow capability provides assistance to help users obtain information, make
decisions, and perform common work tasks via a messaging interface?
A. Agent Workspace
B. Chat bot
C. Virtual Agent
D. Knowledge Chat
E. Now Support
Answer: C (LEAVE A REPLY)
Virtual Agentis ServiceNow'sAI-powered chatbotthat provides assistance via amessaging
interface. It helps users obtain information, make decisions, and complete common tasks without
human intervention.
Conversational Interface# Users interact through chat to get information and perform tasks.
Automated Responses# Uses predefinedtopicsandnatural language understanding (NLU)to
provide relevant answers.
Integration with ServiceNow Applications# Can create incidents, reset passwords, check order
statuses, etc.
Available on Multiple Channels# Works with Microsoft Teams, Slack, and the ServiceNow portal.
A: Agent Workspace# A unified interface for agents to manage cases, not an AI chatbot.
B: Chat bot# A generic term; Virtual Agent is the official chatbot in ServiceNow.
D: Knowledge Chat# No such feature exists; however, Virtual Agent can integrate with the
Knowledge Base.
E: Now Support# ServiceNow's customer support portal, not an AI-driven assistant.
Reference:ServiceNow Docs: Virtual Agent Overview
ServiceNow CSA Official Study Materials
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